Expert's Ultimate Spin Doctor

Credits

Product Manager: Alvin Mullins
Quality Assurance: George Moneo, Patty Fuquen, Randy Abdool, Rick Haylock, Manny, Perez, Sean Pereira
Documentation Layout: James H. Smith IV
Documentation Editor: Mia Leonin
Development Art Department: Greg Lampkin, Omar Rodriguez, Jr., Glen Milan, Enrique Saldarriaga, Noel Fung
Online Manual Edition: July 1996
Copyrights and Trademarks

©1996 Expert Software, Inc. All Rights Reserved. Design and documentation ©1996 Expert Software, Inc. Program Development. The user's guide and the software described in it are copyrighted with all rights reserved. The user's guide or software may not be copied in whole or part, without written consent of Expert Software, Inc. You may not sell, rent, lease or transfer copies of the user's guide or software in any other way without the prior consent of Expert Software, Inc.

Expert Software, Inc. and the Expert Brand logo are Trademarks of Expert Software, Inc. Crayons, Swfte and the Swfte logo are trademarks of Swfte International, Ltd. ©1996 Swfte International, Ltd. Microsoft is a trademark of Microsoft Corp. All rights reserved. All other trademarks are acknowledged.
This chapter covers the scoring objectives, key controls and characters of the game. Also get pointers on maneuvering your clock hand in Ultimate Spin Doctor.

Welcome to Expert's Ultimate Spin Doctor

The overall object of Ultimate Spin Doctor is to achieve a high score by completing game levels, as quickly and with as many points as possible.

As you play each level of Ultimate Spin Doctor, the object is to maneuver your clock hand across a field of dots to the sparkling “goal” dot while avoiding dangerous obstacles such as colored clock hands, moving spikes, bullets, oil globs, and closing doors. You can also gather “bonus” dots to increase your score. Each Ultimate Spin Doctor level presents a new challenge with varied game obstacles. Even the hardest-looking levels can be easy if you find just the right path.

Game objective and scoring

After completing a level, you receive a completion bonus that varies with your difficulty setting.

**Bonus dots**

You receive 1,000 bonus points for the first bonus dot you gather in a level, 2,000 for the second, etc., up to a maximum of 5,000 bonus points for the fifth bonus dot and each additional bonus dot.

**Speed bonus**

You receive a speed bonus by completing a level in less than the allotted time. The quicker you are, the more points you receive.

To complete a level and receive a completion bonus, you must “grab” the goal dot shown in the bottom-right corner above.
**Bonus dots** are translucent and may be either clear or colored. Gather a bonus dot by swinging or flipping onto it. The color of a bonus dot does not affect its value. Each enemy clock hand above is rotating around a bonus dot. There are initially 8 bonus dots in this example, but one is quickly gathered.

The hourglass gives you 10 seconds of bonus time and 1,000 points when you swing over it. The more time you have at the completion of a level, the higher your speed bonus is.

**Starting a game**

1. Type your name into the area for **Player 1**. If you are playing a Two Player game, click the **Two Player** button, and type the second player's name into the area for Player 2. Choose keyboard or mouse control for each player. We recommend keyboard control.
2. Select a time limit and a difficulty setting.
3. Adjust the music and game sounds as desired, using the buttons and **Options** menu.
4. Select a numbered level from the level menu by clicking on it. **Note:** You must play the levels in order (but you can skip three levels in the game).
5. Click on **"Play."**
6. That's it!

**"Grabbing," "Flipping," "Swinging," and "Bouncing"**

You can move your clock hand from dot to dot by "grabbing" any adjacent dot as the moving end of your clock hand passes the dot. There are two different methods of grabbing a dot. In the first, called a "Swing," your clock hand rotates in the opposite direction around the second dot as it did around the first. In the second, called a "Flip," your clock hand rotates in the same direction around the second dot as it did around the first.

Instead of "grabbing" an adjacent dot, you can "Bounce" your clock hand off the dot to reverse your clock hand's direction. You can also change your clock hand's direction at any time by doing a "Reverse."

The **red clock hand** is swinging from dot to dot. Notice that the direction of rotation switches as each dot is "grabbed."

To swing from dot to dot, hold down the **(X)** key.
The **green clock hand** is flipping from dot to dot. Notice that the direction of rotation remains the same as each dot is "grabbed."

![Image of green clock hand flipping]

To flip from dot to dot, simultaneously hold down the **X** and the **Spacebar or Z** keys, since flipping consists of swinging and bouncing at the same time. In addition, you may flip using the control key.

The **blue clock hand** is bouncing back and forth.

![Image of blue clock hand bouncing]

To bounce off a dot or wall, hold down **Spacebar or Z** key.

### Key Controls and Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Key Controls Player 1</th>
<th>Key Controls Player 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swing</td>
<td>X</td>
<td>2 or 6 on keypad</td>
</tr>
<tr>
<td>Bounce</td>
<td>option</td>
<td>3 or 5 on keypad</td>
</tr>
<tr>
<td>Flip</td>
<td>control (or option AND )</td>
<td>1, 4, or + on keypad</td>
</tr>
<tr>
<td>Reverse</td>
<td>space bar</td>
<td>enter or 0 on keypad</td>
</tr>
</tbody>
</table>

**Hint #1:** To effectively swing, flip, or bounce, press the appropriate key(s) well before your clock hand passes by an adjacent dot, and keep the key(s) depressed until just after the swing, flip, or bounce is successful. With the exception of reverse, pressing keys and then releasing them when your clock hand is not passing a neighboring dot has no effect.
Hint #2: You do not have to release the Swing, Flip, or Bounce keys for them to take effect multiple times. For instance, if you want to swing indefinitely, simply hold down the swing key and don’t release it.

**Mouse control**

Choose mouse control in the Game Options Screen. Your clock hand must be within 1/4 revolution of the dot you wish to grab next when you click.

<table>
<thead>
<tr>
<th>Command</th>
<th>Mouse Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse</td>
<td>Click on or near the dot you occupy. This is the “reverse” region.</td>
</tr>
<tr>
<td>Swing</td>
<td>Click once anywhere outside of the “reverse” region.</td>
</tr>
<tr>
<td>Flip</td>
<td>Double-click anywhere outside of the “reverse” region.</td>
</tr>
</tbody>
</table>

On medium and hard difficulty settings, we recommend using keyboard control.

**Levels in Ultimate Spin Doctor**

The levels in Ultimate Spin Doctor must be played in order, starting at the lowest level. However, if you are unable to complete a level, you may elect to use one of your three “skips” to temporarily bypass the level, and move on to the next level. If you use up your three skips, you must complete any one of the three levels you skipped to free up a “skip” for a subsequent level.
1. Status area

At the top of the Ultimate Spin Doctor display is the status area, which provides important information about the game, including the level number and name, the time remaining in the level, and your score for this level. Note that in a two player game, the scores shown are the cumulative scores for all levels played.

2. Your Clock Hand

Your clock hand is the gold-colored and continuously spins around one of the dots on the game screen. (Player 2's clock hand is colored black).

3. Game area

This is where the game is actually played also where all the obstacles are place.

4. Triggers

Triggers work just like door switches. They come in three colors. Scattered around the screen are some number of matching-color guns. The guns are stationary, and each has a number of fixed barrels. Whenever any clock hand passes over a trigger, all guns of the same color shoot a bullet. The bullets always travel at the same speed. Bullets stop at walls, but pass through enemy clock hands.

5. Enemy Clock Hands

Enemy clock hands are colored blue, green, or red. If an enemy clock hand crosses your clock hand at any time during the level, you must restart the level. If you're careful, you can grab and ride on the same dot that an enemy clock hand is on, but don't follow too closely!

Each enemy clock hand follows a defined path of swinging, flipping, and bouncing. For instance, one clock hand may simply spin on one dot. Another may swing from one dot to another. When you first enter a level, watch and learn the enemy paths so that you can plan your avoidance strategy. Note that most objects in the game that are dangerous to you are harmless to enemy clock hands.

The color of a dot corresponds to the color of the clock hands that grab that dot during the level. For instance, the dot around which a red clock hand spins is colored red. Two dots that a blue clock hand swings or flips between are both colored blue. If clock hands of more than one color grab a given dot during a level, that dot appears multicolored.
6. **Bonus dots**

A Bonus dots are translucent and may be either clear or colored. Gather a bonus dot by swinging or flipping onto it. The color of a bonus dot does not affect its value. Each enemy clock hand above is rotating around a bonus dot. There are initially 8 bonus dots in this example, but one is quickly gathered.

7. **Up/down dots**

- Up/down dots have matching-color switches. When a clock hand passes over a switch, the up/down dot set either drops down or is raised up to a normal position. Clock hands cannot occupy up/down dots that are down.

8. **Oil glob**

An oil glob sits motionless near a dot. If your clock hand passes over the glob, the glob starts creeping slowly towards the dot. Finally the glob flows slowly up the dot and coalesces into a droplet.

9. **Hourglass**

The hourglass gives you 10 seconds of bonus time and 1,000 points when you swing over it. The more time you have at the completion of a level, the higher your speed bonus will be.

10. **Exploding bomb**

The exploding bomb inflicts damage in several ways: it kills nearby clock hands (including perhaps your own!); it destroys other nearby objects such as spikes, oil droplets, walls, and switches; and it removes the bonus from nearby dots. **Note:** The exploding bomb inflicts damage in several ways: it kills nearby clock hands (including perhaps your own!).

11. **Walls**

Walls are stationary obstacles that your clock hand bounces off.

12. **Spike(s)**

A spike is a small red obstacle that can be found anywhere in a level. A spike may be stationary or moving. Moving spikes orbit a dot, exactly as clock hands do. They orbit at a point corresponding to the center of a clock hand and move at a constant speed. If your clock hand hits a spike, you must start the level over.
The Options screen is where you choose your game options in Ultimate Spin Doctor. Click on the buttons to make your selections.

When you are finished with the options screen, press the “Play” button to begin the game or select “New Game” from the menubar.

If you do not start a game, the Options screen automatically returns to the title screen. Just click the mouse or press a key to return to the Options screen from the title screen.

**Level and Best score**

Select which game level you want to play by clicking and highlighting it. The best score for that level is displayed to the right. The letter next to the score was achieved on (C=Child, E=Easy, M=Medium, H=Hard). Each group of 10 levels names within a stage until you reach the first level of that stage.

If you become stuck, the “Skip Level” button below lets you skip a level you haven’t completed and move on to the next level. You can skip a total of three levels. If you go back and complete a level you previously skipped, you can then skip a different level.
Player 1:
Type your name in the space to the right. Your Ultimate Spin Doctor rating, listed below, is based on your total score. Just click on either "Keyboard" or "Mouse" to choose one as your game control. We recommend playing Ultimate Spin Doctor with the keyboard.

Game Type:
You can choose between a single-player or a two-player game.

Time:
You can decide how much time you want to play Ultimate Spin Doctor in one session be setting a time limit. Click on the up and down arrows to set a time limit between 5 and 55 minutes in 5-minute increments. In addition, you can set no time limit. Don’t worry if you run out of time; Ultimate Spin Doctor asks you if you want to continue playing. Think of the time limit as a reminder not to play longer than a 15-minute coffee break!

Difficulty:
Ultimate Spin Doctor has four difficulty levels: Child, Easy, Medium and Hard. Most significantly, entire levels are different depending on the difficulty setting. Easier difficulty levels have simpler and fewer obstacles than tougher ones. The difficulty level also affects the speed of everything on the game screen (including your clock hand and enemy clock hands) and amount of time you have to complete a level (which is unlimited in Child mode).

Options:
You can turn the background music and sound effects on or off by clicking on the buttons.
**Other Obstacles in Ultimate Spin Doctor**

**Doors**
Doors act the same as walls do, except that doors can open and close. A door is controlled by one or more switches. Each switch, in turn, may control one or more doors. The color of these switches matches the color of the door “trim” (the bars on either side of the door).

**Switch**
A switch is activated whenever any clock hand passes over it. Activating a switch starts closing the door (if it’s open), starts opening the door (if it’s closed), or changes the door’s direction (if it’s in the process of opening or closing).

**Wallbusters**
Wallbusters are objects that “float” until your clock hand comes by and “whacks” them in a particular direction. If the Wallbuster hits a wall, the wall disintegrates in a cloud of dust. They are needed to strategically eliminate walls. Wallbusters bounce off doors.

**Droplet**
The droplet sits on a dot for a short while and then starts chasing your clock hand by dripping between dots. If the droplet lands on the dot around which your clock hand is spinning, you must start the level over. If you grab a dot that a droplet is sitting on, you also must start the level over. There is no harm in simply passing your clock hand over an oil glob. Note that the droplets clone themselves at random times, with the two droplets moving in orthogonal directions.

**Lighter**
When your clock hand passes over a lighter, it ignites a spark which flares red and then turns white as it starts to burn down the fuse. If your clock hand hits the spark after the spark turns white, you must start the level over. Eventually, the spark detonates a bomb.

**Moving dot(s)**
A Moving dot spends 1/4 of your clock hand revolution moving up or down or left or right.

**Extended dots**
Extended dots are “long” dots that are essentially connections between two dots. When a clock hand grabs an extended dot, it slides along it. While your clock hand is sliding along an extended dot, it can grab any dot it passes by, including a parallel extended dot.
Ring dot
A ring dot disappears as soon as your clock hand releases it and grabs another dot. If an enemy clock hand is on a ring dot that has disappeared, the enemy clock hand flickers and disappears.

Slowdown dot
• While your clock hand is on a slowdown dot (which has a triangle on it), all enemy clock hands move at one-half of their normal speeds.

Station dot
If you grab a way station dot (which has a cross on it) partway through a level, and if you later lose a life and restart the level, your clock hand appears on the way station dot (not at the level's original starting dot). When you restart the level, you'll start with as much time left as you had when you first grabbed the way station dot.

Death dot
A death dot (which has a square on it) is perfectly safe to grab. However, you cannot switch from one death dot directly to another.

Hyperdots
Hyperdots come in identical pairs. If any clock hand grabs a hyperdot, the clock hand is instantly transported to the matching hyperdot, with no change in the clock hand's angle or rotation. Some pairs look very similar to other pairs, so examine them closely!

Shield dots
Shield dots make your clock hand invulnerable to enemy clock hands (but nothing else) as long as you stay on the shield dot.
Ultimate Spin Doctor's Menu

Game Menu

The Game menu bar appears when you move the mouse to the top of the game screen.

Under the File menu, you can start a new game (score is reset in two player game), restart a level (score is not reset in a two player game), end or abort, pause, and quit. Command key equivalents are shown in the menu.

The Options menu allows you to control how the game music is played. The Swing Indicator provides a visual indication of which way you swing if you grab a dot.  

*Note:* Only on the Macintosh: you can control the volume of the game music and game sound.  

This option under the File menu is designed to provide future expansion of your Ultimate Spin Doctor game.
Some Frequently asked questions from previous players of Ultimate Spin Doctor.

Frequently Asked Questions

Ultimate Spin Doctor’s Q&A

Q. How do players play each other?
A. The players compete to complete the level and maximize their individual cumulative GAME scores. Each player has a cumulative GAME score (as opposed to a single level score). The level ends when one or the other player either dies, grabs the goal dot, or the level timer runs out. If both players reach the goal dot, the first player to grab the goal dot receives more bonus points than the second player. Upon the death of one player, a level continues until the second player completes the level or dies. The game ends when the game time (which is set in the Options screen) expires and the players decide not to add extra time.

Q. How are Bonus dots valuable in attaining a high score?
A. Since bonus dots are quite valuable in attaining a high score, it can often be worth your loss in speed bonus to spend some time gathering extra bonus dots before completing a level. However, most bonus dots are guarded by enemies, so pick and choose carefully.

Q. How much damage an exploding bomb will cause?
A. How much damage an exploding bomb causes depends on exactly when it’s detonated. You can control this by passing your clock hand over the lighter at the correct time.

Q. Are the oil droplets dangerous in the game?
A. Watch the oil droplets carefully to learn how they chase you. You may be able to avoid them once you have learned their secret.
Q. Is it possible to take a look or study a level before getting through it?
A. Remember that you can study a level before trying to get through it, since the level timer doesn't begin until you push down a key. Try to study what the enemy clock hands are doing before plunging into a difficult level.

Q. Can you “hover”?
A. You can “hover” between a wall and a dot by holding the Bounce key and repeatedly bouncing off the wall, then the dot, as the green clock hand is doing.

Q. What is the key things to know when trying to mastering Ultimate Spin Doctor?
A. The essence of mastering Ultimate Spin Doctor is understanding the difference between swinging and flipping. Notice that when you flip, your clock hand always maintains the same direction of rotation.
INDEX

C
Copyrights and Trademarks
Credits

F
Frequently Asked Questions

G
Game Menu
Game Objective/Scoring
Grabbing/Flipping/Swinging/Bouncing

K
Keyboard Controls/Commands

L
Levels
License Statement

M
Main Interface
Mouse Control

O
Obstacles
Options Screen

P
Product Support
Program Overview

S
Starting a Game
Expert Software License Statement

This software is protected by both United States Copyright Law and International Treaty provisions. Expert Software, Inc. grants you this license and your continued use confirms your agreement. Therefore, you must treat the software “just like a book,” with the following single exception: Expert Software, Inc. authorizes you to make archival copies of the software for the sole purpose of backing up your software and protecting your investment from loss.

By saying “just like a book,” Expert Software, Inc. means, for example, that the software may be used by any number of people and may be freely moved from one computer to another, so long as there is no possibility of being used at one location while it’s being used in another. This is just like a book that cannot be read by two different people in two different places at the same time; neither can this software be used by two different people in two different places at the same time.

This agreement shall be construed, interpreted, and governed by the laws of the state of Florida and shall inure to the benefit of Expert Software, Inc. its successors, administrators, heirs, and assigns.

Limited Warranty

Limited warranty on product disks. To the original buyer only, Expert Software, Inc. warrants the disk or disks on which this product is recorded to be free of defects in material and workmanship under normal use for a period of 90 days from the purchase date. Any implied warranties of merchantability or fitness for a particular purpose are limited in duration to the period of 90 days from the date of purchase. Your sole and exclusive remedy in the event of a defect in material or workmanship under normal use is expressly limited to replacement of the defective item.

This warranty gives you specific legal rights, and you might also have other rights which vary from state to state.

No warranty on product software or User’s Guide. Even though Expert Software, Inc. has tested the software and User’s Guide and reviewed their contents, Expert Software, Inc. and its distributors and dealers make no warranties, either expressed or implied, with respect to the fitness for a particular purpose. The software and User’s Guide are distributed solely on an as is basis. The entire risk as to their quality and performance is with you. Should either the software or User’s Guide or both prove defective, you (and not Expert Software, Inc. and its distributors and dealers) assume the entire cost of all necessary servicing, repair, or correction. Expert Software, Inc. and its distributors and dealer will not be liable for direct, indirect, incidental, or consequential damages resulting from any defects in the software or User’s Guide, even if they have been advised of the possibility of such damages.

Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of incidental or consequential damages, so the above limitations or exclusions might not apply to you.

Copyright

© 1996 Expert Software, Inc. All Rights Reserved. All Rights Reserved Worldwide. The user’s guide and the software described in it are copyrighted with all rights reserved. The user’s guide or software may not be copied in whole or part, without written consent of Expert Software, Inc. You may not sell, rent, lease or transfer copies of the user’s guide or software in any other way without the prior written consent of Expert Software, Inc.

Trademarks

Expert Software and the Expert brand logo are trademarks of Expert Software, Inc. Microsoft and Windows are registered trademarks of Microsoft Corporation. Macintosh is a registered trademark of Apple Computer Inc. All other trademarks are acknowledged.
**Product Support**

Your purchase of an Expert product includes free product support to help you get the most out of your software. All Expert products are thoroughly tested and come with a Help File, User’s Guide and/or Online Manual. In most cases, the answers to many of your questions are in the Help File, User’s Guide and/or Online Manual. If you are having problems starting or running the program, please feel free to contact us.

24 Hour Automated Support

- Find answers to frequently asked questions on the worldwide web at http://www.expertsoftware.com
- Use our Fax Back System for support and product information at (800) 772-5706.

E-mail Addresses

- You can send e-mail to support@expertsoftware.com or sales@expertsoftware.com

Mailing Address

800 Douglas Road, Suite 750, Coral Gables, FL 33134 or P.O. Box 144506, Coral Gables, FL 33114-4506.

Telephone Product Support

- Contact a friendly Expert Product Support Specialist Monday through Friday, 9:00AM to 5:00PM EST. (Eastern Standard Time).
  - Telephone (305) 567-9996
  - Fax (305) 569-1350.

If you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program version number from the front of your program disk or back of the CD jewel case, as well as the following information:

- If you have a Macintosh®–compatible computer:
  - Please have the model, system software version and amount of memory available.
- If you have a Windows®– or MS-DOS®–compatible computer:
  - The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS prompt.)
  - The version of Windows® installed on your computer.
  - The type of hardware you are using:
    - The brand of computer you own,
    - CPU type (80386, 80486, Pentium®),
    - Video type (EGA, VGA, Super VGA),
    - Model and type of video card, and
    - Model and type of printer.
  - The exact wording of any messages that appeared on the screen.
  - What happened and what you were doing when the problem occurred.
  - We encourage Windows® 3.x (or MS-DOS 6.x) users who need product support to print an MSD report. Have it available for the Product Support Specialist who answers your call. You will find the MSD (Microsoft Diagnostics) program in either the Windows or the DOS directory.